Scripting and Programming for Modeling, Simulation, and Control

Copyright © Bruce Char,
2008-09
List of Tables

Arithmetic operations in Maple ................................................................. 9
Some examples of Maple error messages .................................................. 12
Create Document Block to force a Math input area wherever the cursor is placed .................................................. 14
Example of a vocabulary mistake .............................................................. 15
Maple save menu operation ..................................................................... 16
Maple save dialog box ............................................................................. 16
The Maple state display ........................................................................... 17
Plot created by right-click -> Plot -> 2DPlot .......................................... 20
User-configured plot using PlotBuilder instead of 2DPlot .................... 20
The Expression palette. The top of the "Common Symbols" palette is also visible at the bottom of the picture .... 21
Examples of palette-driven computation ................................................ 22
Examples of computing with approximate solving .............................. 22
Evaluate at a pointExample ................................................................... 23
Operations on equationsExample ............................................................ 23
To our colleagues and families, who supported us in trail-breaking.

To our students, who learn how to work with the new and different.
1 Introduction -- Technical computing at the turn of the century

1.1 Chapter synopsis

1. We explain what technical computing is about, why it's done with a machine and what kinds of devices are used to do it.

2. The advantages doing calculation with a computer are surveyed.

3. Maple, a system for technical computing is introduced and contrasted with some of the other choices available today.

1.2 What is technical computing? What kinds of technical computing are there?

Well, obviously, it's "computing done for technical work" -- primarily science and engineering, but any other field where mathematical and scientific reasoning is used, which nowadays can include other fields such as finance and business, medicine, or digital media. The success of such reasoning in these fields is well-known. Students of those fields need to become experienced and develop proficiency in how it's done to be able to obtain success in the same way.

You are probably familiar with numerical computing since it's done even without computers, with paper and pencil or with calculators in high school or even earlier. You probably have also seen graphing calculators do simple kinds of graphical computing, also sometimes known as mathematical visualization. In addition to this, computers can and are used to do algebraic computing -- computing where the answer is a formula rather than a number, as well as deductive or logical computing -- using logic or deduction to find answers.

In this course, we will concentrate on numerical, symbolic and graphical computing, although we will see some instances of deductive computing as well.

1.3 What are the advantages of doing technical calculation with a computer?

One advantage is greater quantity of calculation -- computers can do calculations billions of times faster than humans and thousands or millions of times faster than calculator-driven computation. Using them makes some things feasible that are not possible any other way: As you've seen with your high school physics, chemistry, and math courses, scientists and engineers often work with mathematical models -- systems of equations, symbols, and mathematical relations that try to describe key aspects of a situation. Calculation with models helps answer questions about the situation being modeled: How much fuel will be used in this operating scenario? How long will it take to heat up the furnace to 265 degrees? Computer simulation loads a model with some initial conditions, and then through calculation produces predictive results. Simulation can be used to make forecasts such as: how fast will the vehicle be moving after 5 seconds? How far will the pollutants move underground after being buried five years?

Computers make it possible to use models that require much more extensive calculations to reach conclusions. The payoff may be better predictions. Extensive calculation also makes it possible to generate and present more information. Computer visualization goes beyond that to highly detailed pictures or animations of a situation described through a mathematical model. This can lead to better insight and understanding.

Another advantage is that it is easier to make a lasting written record of the work. One of the big differences between professional technical work and homework is that the modeling and calculation has lasting value: it matters to more than one or two people, and it is being used in an on-going project. In a professional situation, a worker may need to go back and review the work a year later, long after the details are faded from easy recall. Other people may want to reuse the programming and will need to be given an explanation about how to use it. Since they have long-term value,
it is beneficial to put them into a form suitable for easy future reference and reuse. Thus the work typically includes both programming and documentary explanation.

1.4 The spectrum of devices for technical computing

Back in the days of the original electronic computers developed during and immediately after World War II, the only kind of device you could use for technical computing (which was the only computing that could be justified in those days) filled up a whole room and needed an extensive staff to support.

An early computer

ENIAC, one of the first electronic computers, being programmed by Herman Goldstine at the University of Pennsylvania circa 1946. (US Army photo) Originally intended to do artillery calculations, it was used for the design and development of the first thermonuclear weapons.

See http://www.seas.upenn.edu/~museum/.

Today's users have a choice of a wide variety of devices:

Personal computers

Typically a computer for individual use can be expected to have the following features:

Processing capability of a billion or more arithmetic or memory operations per second. Significant amounts of calculation are used in doing the graphics involved in processing digital media or supporting the artificial worlds presented in computer games. This same power can be used to do the simulation and exploration in many common kinds of scientific and engineering situations. This course is about using that calculation power.

Standard selection and pointing devices, keyboard and mice. Some computers support "tablet" operation which allow use of a pen writing on the display. The display area and input devices make it easy to enter information via text or by pointing/selection. While the World wide Web has made much processing possible with just "pointing and clicking", the complexity and mathematical sophistication of the models used in current technical computing outstrip the capabilities of current "point and click" technology. Some (computer programming) language-based interaction is necessary to handle things deftly. This requires a more knowledgeable user, but many people find that the extra power is worth the learning effort.

A screen capable of display information equivalent to one or more 8 1/2 x 11 inch pieces of paper. This helps support the development of documentation, or of more complex visualizations.

Local storage capable of storing a significant fraction of the text of the books in the Library of Congress. Of course, it's easy for a personal media collection to fill up this kind of storage, but it should not be forgotten that the billions of characters that this storage represents can store years or decades of efforts of computer programmers.
Connection to the internet, which makes it easier to communicate and share work with others, and to download new programming. From the viewpoint of technical computing, that it's easy to import and run substantial amounts of programming.

**High performance computers, also known as "supercomputers"**

While hand held devices and personal computers are used widely by the general public for non-technical purposes, there are a class of computers that are used primarily for mathematically-based computing. Typically instead of billions of numerical operations per second ("gigaflops" -- billions of floating point operations), they employ multiple processors in parallel to do trillions of operations ("teraflops") or quadrillions ("petaflops"). The hardware, personnel and energy costs of such computers are significant, so typically they are available through centers used through the Internet from many locations. The kinds of technical problems such devices are used for would include: simulation of complicated physical situations, such as for climate prediction, astrophysics, or engineering design (aircraft, groundwater, large building, automobile).

Using such large devices incur significant expense, from hardware, software and support staff costs, as well as electrical power consumed. For example, the U.S. Department of Energy has an IBM computer at its Los Alamos National Laboratory in New Mexico, USA capable of 1 quadrillion ($10^{15}$) numerical operations per second. It consumes 2345.50 kilowatts when it is running. (reference: http://blog.enterpriseitplanet.com/green/blog/2008/06/green-petaflop-ibms-roadrunner-wins-supercomputer-top-spot.html) The National Center for Computational Sciences (NCCS) at Oak Ridge National Laboratory in Tennessee, USA which has several large supercomputers, has a 2008 annual budget between $80 million and $100 million. (reference: http://news.cnet.com/8301-13772_3-9985500-52.html). A typical personal computer might be capable of approximately 4 billion numerical operations per second, so the Blue Gene computer at Los Alamos provides roughly $0.25 \times 10^6 = 250,000$ times more computing power.

Typically the programming is developed on personal computers, then moved to the larger devices. Usually the expensive supercomputer time is spent primarily on numerical computation, rather than on providing a nice-to-use interface for users. However, the results of a supercomputer may be shipped over the Internet to a personal computer so that a scientist or engineer may mull over the results in a more contemplative way without incurring additional supercomputer costs.

Multiple computers may be linked together over the Internet to get all the pieces of a particular elaborate computation done. This may have the supercomputers performing the massive numerical computations, while other smaller or personal computers linked in may be displaying the results to a distributed team of investigators who are collectively digesting results and steering the on-going work.

**Hand held or mobile devices**

*Calculators* are useful for casual computation, where one wants to figure out the solution to a small problem once. It's easy to punch in a few numbers and operations and to read the answer on the display. As inexpensive and small mobile devices, these are typically more limited in:

1. memory (limits to computation size and to built-in features)
2. energy consumption (slower processor speed)
3. form factor (keyboard and display too small for more than casual technical use)

Typically calculators are not networked, making it harder to share results to transfer them elsewhere to continue the work.
A high-end calculator in 2009

The TI-Nspire with CAS is a recent generation calculator from Texas Instruments. It can do numerical and symbolic calculations, as well as graphing. According to ticalc.org (http://www.ticalc.org/basics/calculators/ti-nspire-cas.html) it has 16Mb memory, 20Mb storage and has a 150MHz processor. This makes it have about 100 times less memory, 8000 times less storage, and is about twenty times slower than a typical laptop with a dual core 1.5GHz processor, 2Gb memory, and 160Gb disk. Its screen is 240 x 320 pixels, giving it about twenty times less display area than a typical laptop. This is one of the first generation of calculators with limited wireless networking available as an add-on.


Smartphones, personal digital assistants (PDAs), media players have in theory the same processing capabilities as calculators although most of them are not used extensively for technical computation. One advantage of these kinds of devices is that are typically networked so that it's possible to get a more powerful computer somewhere else in the Internet "cloud" of computational resources to do some of the work.

In the future there may be more convergence of the capabilities of all "mobile small form factor" devices. However the small form factor and the limits to energy consumption will probably continue to constrain the capabilities of such devices compared to larger ones.

**Dedicated controllers**

Even some kinds of toasters have microprocessors in them nowadays. "Smart homes" may network many appliances and home features such as HVAC and lighting control. While these devices are merely configured rather than programmed by end users, students of technical computing should not forget that this is another place where programming is necessary. The economic reasons for switching to computer control of devices appear to be the greater flexibility and variety of control that can be developed at modest cost through programming for many kinds of devices. The kind of programming done for device control often has a mathematical basis. Although the processors in dedicated devices are typically a few orders of magnitude slower than those of personal computers or even smartphones, the programming languages used for them are often the same or similar to those used in personal computing.

**1.5 Maple, a system for technical computing**

In this course, you will learn how to do various kinds of technical tasks using Maple. The first version of Maple was developed in the early 1980s at the University of Waterloo in Ontario, Canada, but has since undergone many refinements and extension. (In Fall 2009, we will be using Maple 13.) Maple's original emphasis was on algebraic computing, so it was used by those who needed formulas as results for their work. In the early '90s it was used extensively in calculus classes as a way of supporting exploratory experimentation and more extensive experience with "applied" problems. More recently it has expanded its domain into the symbolic, numeric, and graphical calculations done more generally in scientific and engineering modeling and simulation.

Today, Maple supports numerical computing and graphical visualization about as well as it does symbolic computing. It has its own programming language but also has ways of doing calculations through the graphical user interface (GUI) that are a kind of augmented "point and click". The default way of interacting with Maple also allows you to mix documentation and computing instructions and results. Thus it's particularly easy in Maple to produce documents that produce a well-documented solution -- a description of the problem, the explanation for how to solve it, and the computations that produce the details of the answer and evidence to justify its correctness.
1.6 What about Systems X, Y, Z, ...?

There are a variety of systems and programming languages used for technical computing nowadays. In a large technical establishment such as a university or research lab, one might find, in addition to Maple the use of systems such as: Python, Matlab, C, Mathematica, Java, Octave, Macsyma, Sage, Axiom, or Fortran.

The vast array of tasks computers can be used for, the multiplicity of philosophies of system design, and the rapid and unrelenting nature of progress in computing means that there is no "best system" for any situation. Each system has its technical strengths. There may also be historical, cultural, or economic reasons why certain systems are used in certain places which co-exist with the technical justification. As with all popular and demanding activities, there are many products in use.

One important ramification of this is that students in technical fields must expect to become familiar and proficient in more than one programming system. Studying more than one brings greater knowledge of what's possible, and the advantages in judgment that comes from knowledge of diverse ways of achieving a goal. It also allows one to function effectively as a team member in larger cross-organizational efforts and to better to cope with the diversity in computing cultures that's out there.

1.7 Why pick Maple as the first system?

1. It is an interactive system, facilitating quick exploration of new ideas. Compared to languages such as C++ or Java, one can immediately start up an interactive system and get calculation results. It's also possible to enter computational scripts, which are sequences of steps that are less elaborate to set up than programs. The scripts can be easily re-run to do "what if" exploration just by changing a line or two in the script. The worksheet interface to Maple allows sophisticated mathematical typography and graphics as well as mouse- and palette-driven input.

2. It can handle calculations with formulas. Rather than figuring out the formula yourself, you can even get Maple to calculate the formula for you. While many mathematical calculations produce numerical results, formulas are needed to specify how those results are produced. Designers or developers often need to find and create the formulas rather than to just copy them from a book. A system where formulas are easy to represent and easy to create supports this kind of work. A system that allows you to represent and calculate both numbers and formulas makes it easier to do and document technical calculation than a system that just works with numbers.

3. It supports a variety of data structures that support technical computation: formulas, equations, functions, sets, lists, tables, vectors, and matrices. Rather than having calculations done with a number of digits that's fixed forever, it is easy to change the precision if more (or less) precision is needed. Having higher-level interaction with the computer is usually more productive of human time. Having all of these entities as "first class entities" in the system requires less mental effort by the user, since they do not have to translate what they are thinking about (e.g. a table of formulas) into the terms that the computer is using. Rather, the computer language accommodates the human style of thought.

4. It supports documentation as well as calculation. From the instructor's point of view, it's easier to create documents that explain Maple because we can use Maple both to handle the calculation and the presentation of results. For students, having a file with both the directions that cause the computation and the results makes it easier to present the work cleanly for grading, and for future reference. For professionals doing technical work, having an integrated environment where text, programming and results can be presented together can be a convenience.

5. It has a "conventional programming language". An objective of this course is to make you become familiar enough with some of the standard elements of programming (e.g. assignments, conditionals, loops, procedure definitions) so that you can use them creatively to handle certain common situations that can't be handled through point-and-click or built-in operations. These elements will be found in highly similar form in the languages used by many other systems used for technical work.

6. The mathematics of modeling and simulation is an explicit feature of the language. While its programming language is conventional, Maple's language has an important added plus -- you can work over expressions, equations, functions, and other mathematical objects just as conveniently as if they were numbers or characters. Conventional languages (e.g. Java) can represent arithmetic operations -- multiplication, addition, subtraction, and division -- but...
after that there are special tricks and conversions that you must perform to bridge the gap between what is written in
the program, and the mathematical ideas that you are trying to use in the model. It's more straightforward in Maple to
represent the mathematical model and the computation based on it. This ease of expression and comprehension by
programmers -- has a hard-headed dollars and sense payoff. Less programmer time can be spent developing a compu-
tation. There is also an efficiency advantage to explicit representation of formulae: it is possible to use systems such
as Maple to automatically improve the quality and efficiency of simulation calculations. This again leads to lower costs
of doing the work. We think this is a software engineering advantage: it's cheaper in the long run to do technical work
with languages with such features. We believe that most languages supporting technical work will have such function-
ality built-in into them.

### 1.8 For the curious: using more than one system

Any user of computers who expects to use them professionally for design and investigation must expect to eventually
learn multiple systems. Using computer applications for work is like using tools in a workshop-- you would not expect
to use one tool to do all tasks, even if the tool, like Maple, has "Swiss Army Knife" capabilities. Features that make it
easier to do certain kinds of things may slow down doing other things. Even when systems overlap in features, they
typically have differing philosophies and different technical strengths, which means that certain kinds of work may be
significantly easier in one system than another. For example, developing something in Mathematica or Maple may be
good and quick for a personal computer, but making the same programming work on a supercomputer may take a lot
of effort. Systems with major development effort behind them (such as Maple and those mentioned in the "section
above) seem to have many similarities and functionality. If major effort were needed to acquire expertise in multiple
technical applications, then prospects would be grim for the computing public. What makes things work out is this: at
the introductory level, the difference between casual computing and professional technical computing is the style of
working (higher emphasis on documentation, justification and ease of reuse), and the use of language-based com-
mands/programming needed to do the more sophisticated operations in technical work. "Crossing over" means getting
over the hurdles of learning the new style of work, and interacting with computers using computer languages. Once
this hurdle is passed, it should take only incremental effort to acquire expertise in the second, third, or \( n \)th technical
system. Having formal instruction on the first system should provide an explicit introduction into the concepts and the
work processes to facilitate this.

Most systems realize that they cannot be the sole provider of technical computing services. If Institution A uses
Mathematica and Institution B uses Python for their work, then if they expect to use each other's efforts, there has to
be a way of interconnecting programs written in one system with that of another. Thus most systems have interconnec-
tions. For example, the Matlab Symbolic Toolkit allows Matlab users to call Maple to do formula manipulation. Sim-
ilarly, Maple users can link to Matlab and run a Matlab program they've gotten from a colleague as part of a problem-
solving process written in Maple.

Thus: knowledge of basic programming and the concepts of software development make it possible to switch between
systems with only a modest amount of additional effort. Software interconnection allows one to use efforts done by
others in another system without having to translate. Symbolic computation systems like Maple also have the additional
bonus of being able to translate some of their programming between languages. There is a "convert-to-Matlab" feature
for example, or a "convert-to-C" feature. This conversion doesn't work for computations involving formula manipulation
because C doesn't have that feature. But the conversion does work for other kinds of computations involving just
numbers or text.
2 Getting started with Maple's Document Mode: doing technical work with a clickable interface

2.1 Chapter synopsis

1. How to start up Maple and perform simple calculations, algebra, and plots within it.

2. Detecting and fixing typographical mistakes.

3. Introducing mistakes caused by vocabulary misunderstandings and the use of incorrect logic in giving directions.

2. How to save Maple work so that you can refer to it or resume working on it later.

3. How to recover a Maple worksheet if it or your computer crashes.

2.2 A new document

Start up the Maple application (this varies on the type of computer system you have, typically it involves clicking or double-clicking on the Maple 13 icon, but if you can't figure it out yourself ask for a demo for someone who knows). Once the Maple application window appears, a new "document" will appear in the main working area of the Maple application. A flashing cursor will appear with the outline of a small rectangle with dashed lines. The entry mode will read "Math" and "2D Math". You can make the "quick help" black box disappear by clicking on the "close box" circle-X in the upper right hand corner.

After you close the quick help box, you will see the Maple cursor in a small rectangle with a dashed line outline
At this point, what you type will appear in the small rectangle and be regarded as a mathematical expression. In the next section, we describe what to type in order to get something useful to happen.

## 2.3 Exact arithmetic

### Grade school arithmetic

In the math area, type $2 + 3$. "$2 + 3$" is regarded as a mathematical expression by Maple when you type it into the dashed rectangle. As you are typing, the input indicators should say that you are entering Math mode, in 2D Math input:

This expression should show up in the work area. If you hit the enter key, then Maple will evaluate the expression and you should see the result displayed below the input, as in the figure below:

Maple has automatically calculated the answer and given it a label (1). After Maple calculates the answer, the cursor should appear below the result in another dashed-line rectangle. This indicates that Maple is ready to do another calculation. Maple supports all the basic arithmetic operations in a fashion similar to many other programming languages. One thing that takes some getting used to is that $*$ (asterisk) is used to input multiplication rather than "$x" or a centered dot. Another thing that takes some getting used to is that what you type is formatted to look like math notation. Thus
if you type a `/`, Maple understands that you are talking about division and immediately starts formatting your input as if it were a fraction. If you type an asterisk, Maple formats that into a dot (\(\cdot\)). There is also formatting that occurs with caret (\(^\wedge\)) since that is the way you enter an exponent in Maple.

### Arithmetic operations in Maple

<table>
<thead>
<tr>
<th>Operation</th>
<th>Character to type/ character name</th>
<th>Notes</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>addition</td>
<td></td>
<td></td>
<td>2 + 2</td>
</tr>
<tr>
<td>multiplication</td>
<td>* (&quot;asterisk&quot;)</td>
<td>Typing an asterisk makes a center dot ((\cdot)) appear in the displayed expression.</td>
<td>2 \cdot 3 \phantom{(2)}</td>
</tr>
<tr>
<td>division</td>
<td>/ (&quot;slash&quot;)</td>
<td>Typing a slash draws a baseline and then positions the cursor in the denominator. Subsequent typing appears in the denominator. To get out of the denominator and return to normal typing, use the right-arrow key ((\rightarrow)). Multiple divisions are by default conducted left-to-right.</td>
<td>(\frac{2}{6}) \phantom{(2)}</td>
</tr>
<tr>
<td>subtraction</td>
<td>- (&quot;dash&quot; or &quot;hyphen&quot;, typically on the same keyboard key as the underscore. Dash and underscore do not mean the same thing.)</td>
<td>Multiple subtractions are conducted leftmost first.</td>
<td>3 - 5 \phantom{(2)}</td>
</tr>
<tr>
<td>parentheses</td>
<td>( , ) (&quot;left parenthesis&quot;, &quot;right parenthesis&quot;)</td>
<td>Use parentheses to change the order of calculation. They are also good for removing any guesswork by the reader as the order of operations.</td>
<td>((2 + 3) \cdot 5) \phantom{(2)}</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(3 - \left( \frac{2}{5} \right))</td>
</tr>
<tr>
<td>negation</td>
<td>- (&quot;dash&quot; or &quot;hyphen&quot;, typically on the same keyboard key as the underscore). This is the same symbol as used for subtraction</td>
<td>Put a dash in front of a number or parenthesized expression to negate it.</td>
<td>-(3-5 - 2)</td>
</tr>
</tbody>
</table>
Typing a caret moves the cursor to the exponent position. Subsequent typing appears in the exponent. To get out of the exponent and return to the baseline, use the right-arrow key (→).

^ ("caret", typically on the same keyboard key as the number 6)

<table>
<thead>
<tr>
<th>Expression</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>(2^3)</td>
<td>(8)</td>
</tr>
<tr>
<td>(2^3 - 5)</td>
<td>(\frac{1}{4})</td>
</tr>
<tr>
<td>(2^{2^{-1}})</td>
<td>(\sqrt{2})</td>
</tr>
<tr>
<td>(2^{-2} + \frac{4}{5})</td>
<td>(\frac{21}{20})</td>
</tr>
</tbody>
</table>

! ("exclamation mark", typically on the same key as the number 1.)

\(n!\) is the product of all the integers between 1 and \(n\). It is useful in computations that compute the number of possible ways that something could happen. For example, the number of possible orderings of a deck of playing cards is \(52!\).

Let's try out some of these operations. We can enter a sum of two fractions by using "+" and "/". If we type "2/3→+5/6 enter", this is what we see:

\[
\frac{2}{3} + \frac{5}{6} = \frac{3}{2}
\]

The way to get a fraction in is to type a slash (/). As soon as you do so, Maple draws an underscore and positions the cursor underneath the fraction line. The next characters you type appear as the denominator. If you type the "+" right after the "3", the plus will appear in the denominator which is permitted by Maple but not what we want in this situation. To get the plus to appear outside of the fraction, we type the right arrow key (the key with → on it). This moves the cursor out of the fraction back into the baseline of the expression. Then we can enter the + for addition, and another fraction. After we hit the enter key, Maple will simplify the result into a single fraction with any common factors removed from the numerator and denominator.

Now let's do a multiplication. The Maple programming language (like most) uses an asterisk * as the symbol for multiplication. However, Maple displays the expression with a centered dot. This may be disconcerting -- what you type is not what you see. When you are in "math mode" Maple will be using fancy typography to display whatever math you are entering. We'll see more of this shortly. See if you can reproduce this result:
We can mix operations. Try to enter and calculate the following:

\[
\frac{1 + \frac{2}{3 + 4} + 5 \cdot 6 + 7}{8}
\]

\[\frac{67}{14}\]

In order to get that last denominator, we had to select the expression we had entered for the numerator with the mouse, so that the entire contents of the entry rectangle were blue. Then we typed a slash and the denominator appeared beneath it all. An alternative to using the mouse to enter expression (1.2.1.18) would be to use parentheses. If we type "\((1+2/3+4\rightarrow+5^6+7)/8\) enter" we will see this:

\[
\frac{\left(1 + \frac{2}{3 + 4} + 5 \cdot 6 + 7\right)}{8}
\]

\[\frac{67}{14}\]

This allows you to enter complicated expressions without having to use the mouse. Of course, the mouse is still necessary if you want to go back and edit. We observe in passing that a distinctive feature of Maple is that Maple does exact arithmetic with integers and fractions. It keeps fractions as the ratio of two integers. It will, however, automatically simplify such ratios to lowest terms:

\[
\frac{2 \cdot 6}{3 \cdot 7} = \frac{18}{7}
\]

\[-2\]

**Making typographical mistakes**

Making mistakes is a normal part of using any tool, be it a computer or otherwise. You'll probably make as many mistakes learning how to use Maple as you would make when learning a new sport, a musical instrument, or when learning how to write a good essay. Some of them will be obvious as soon as you make them, others will be subtle or harder to figure out how to fix.

When you make some kinds of mistakes, the computer may give you an *error message* For example, if you make a typo and Maple doesn't recognize what you enter as being a valid command, it will complain. Here are some typical error messages. At this stage, some of the messages will make sense and you can react appropriately. Others will use vocabulary that is unfamiliar. For those, the best thing to do is to have a clear idea of what you want to enter (by closely imitating examples that are known to work) and checking carefully that what you have typed was accurate.
Some examples of Maple error messages

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 +</td>
<td>Error, invalid sum/difference. We intended to enter &quot;2 + 4&quot; but forgot to type the &quot;4&quot; before we hit enter (return). The appropriate thing to do here is to correct the expression and hit enter again.</td>
</tr>
<tr>
<td>+ 24</td>
<td>Error, missing operation. This time we mistakenly enter the expression with the symbols in the wrong order. Maple complains that it expects some operation to be entered between the two numbers but there isn't one.</td>
</tr>
<tr>
<td>. + 4</td>
<td>Error, invalid matrix/vector product. We intended to enter &quot;2+4&quot; but typed a period instead of a 2 by mistake. Even though we are trying to do the same thing, the error message is different because a different symbol (the period) in this context suggests to Maple that we are trying to do linear algebra. The appropriate thing to do here is to correct the expression and hit enter again.</td>
</tr>
<tr>
<td>2</td>
<td>Error, numeric exception: division by zero. If we ask Maple to do an impossible operation, it sometimes gives an error (depending on the operation). The appropriate question to ask yourself here is &quot;what should I be dividing by instead of zero?&quot;.</td>
</tr>
<tr>
<td>( \frac{3}{5 + 3} )</td>
<td>Error, unable to match delimiters. We started a sub-expression with a parentheses but forgot to finish it. In Maple, a delimiter refers to a parenthesis -- ( or ) -- a bracket [ or ], or a brace { or }. Delimiters are symbols that mark the beginning and end of an expression. In many instances they are necessary to unambiguously indicate meaning. For example, ( 5 \cdot (3 + 5) ) evaluates to 40, where as the expression without parentheses ( 5 \cdot 3 + 5 ) means 20 because multiplications are always done before additions unless the parentheses indicate otherwise.</td>
</tr>
</tbody>
</table>
\( \left( 3 + \left( 5 + \frac{3}{5} \right) \right)^2 \)

Error, unable to match delimiters

\( \left( 3 + \left( 5 + \frac{3}{5} \right) \right)^2 \)

This is another instance of the same mistake. We wanted to enter \( \left( 3 + \left( 5 + \frac{3}{5} \right) \right)^2 \) but misplaced several parentheses.

, 1 + 3

Error, invalid sequence

\( 1 + 3 \)

We intended to enter "1+3" but typed the extra comma in by mistake. We get an error message that talks about sequences, a concept in Maple that we haven't discussed yet (that's coming in the next few chapters). Maple thinks that the sequence is "invalid" because it usually expects commas to be between items, such as "1,2,x". Maple's language has many other elements in it that we haven't gotten to discuss yet. If you use any of them by mistake then you will see messages with vocabulary we haven't discussed yet. It's a fairly typical experience for new users to see some messages that you won't be able to gather much intelligence from other than the fact that you made a mistake that you should fix,. With knowledge-rich systems such as Maple, you may blunder into sections of the system that you haven't learned yet. The best strategy is to back out of the situation by editing the expression so that it is exactly like something that is known to work.

\( 2 + \frac{3}{3} \)

Error, invalid fraction

\( 2 + \frac{3}{3} \)

This one is fairly obvious. In order to fix it though, we need to know what denominator we intended to enter.

\( 2 + \frac{9}{3} \)

\( \frac{5}{3} \)

### Correcting typographical mistakes

The standard procedure for fixing a mistake is as you would in a word processor: *edit the mistaken input* and *re-execute the computation*. Here are ways of doing this:

Using the mouse, position the cursor where the mistake is. Then use the backspace key to erase the characters you want to get rid of. Type in more characters to replace it..

Use the left arrow key (←) to back up. Typing after backing up then inserts the new typing at the point where the cursor was positioned.

Use the mouse or other "pointing device" of your computer to select a section of what you typed. New typing then replaces the selection of what you typed.
Use the mouse to select a region, then "cut", which you can do through the Maple menu Edit -> Cut. Of course most people use the keyboard shortcut for cutting, which for Windows or Linux is control-X while on the Mac it's command-X.

Copying and pasting (control/command-C and control/command-V) also works in Maple.

You may find that sometimes you attempt to create a 2D Math input area but Maple does not compute a result for the input after you hit the enter key. To create a "clickable math" input area if this happens, place the cursor where you want the input area to be, and use the Format->Create Document Block Menu item of the Maple window:

Create Document Block to force a Math input area wherever the cursor is placed

---

**Exponentiation (powers). Numbers with lots of digits**

Use a caret ^ to specify an exponent (a "power"). In math mode, Maple will position the cursor so that the next things you enter will become the exponent. As with fractions, you can get out of the exponent by using the right arrow key → when you want to go back to non-exponent numbers. Try entering these expressions

\[ 2^3 \]

8

(2.30)
We note that Maple does integer and fraction operations exactly. It will not introduce any rounding error into a computation as a calculator would when the answer requires more than ten decimal digits to write down. There are limits to the number of digits Maple will use for integers or fractions, but they have to do more with ultimate limits of the computer hardware and memory rather than a “pre-ordained” decision about how many digits might be useful to keep. If you type `kernelopts(maxdigits)` into a Math input area on the worksheet, Maple will print out a number which is the maximum number of digits it can handle in any integer or fraction. On the author's computer, `kernelopts(maxdigits) = 268435448`. Note that this is not the value of the maximum number, but how many decimal digits the largest number can have.

For example, Maple can compute the result of

\[ \frac{1}{52!} + \frac{2^{100}}{3^{27}} \] exactly (try it!).

Exact computation is useful not only for doing algebra but also for things such as computing probabilities through counting, or in deriving mathematical formulas for use in simulation or prediction programs.

**Detecting and fixing vocabulary and "logic" mistakes**

There will be other kinds of mistakes where there is no error message, but the response is not what you want. Sometimes this happens because you say something that while grammatical, means something entirely different from what you meant. This could be as simple as entering "2-3" where you meant to type "2+3". Sometimes it is less obvious, such as mistyping the 23-rd digit of a 55 digit number or the 12th term of a long sum. Or worse yet, it could be because you are using the incorrect vocabulary so what you think you are saying does not have that meaning to the computer.

**Example of a vocabulary mistake**

\[ 2 \times 3 + 5 \]

Suppose we were under the (mistaken) impression could use "x" in Maple to stand for multiplication. We might use the above as a way to calculate "two times three, plus five". However, while there is no error message, what is calculated is not the number we were expecting. The first step towards proceeding to fix this is to realize that it's not what we want. To Maple, this is a legitimate calculation -- you want to create a formula that's "two times the variable x3, plus five".

\[ 2 \cdot 3 + 5 \]

Knowing that the proper way to enter multiplication is through a palette, or symbol "*" (asterisk) as explained in
Finally, there are mistakes made because you ask Maple to do the wrong calculation. Even though Maple does what you want, it turns out that what you wanted was wrong!

For example, you may read a word problem and decide to solve the equation $3 \cdot x + 2 = 6$, whose solution is $x = 4/3$. But when you plug the solution into the circumstances of the problem, you find that it doesn't solve the word problem. The problem may be because you used faulty logic to decide that $3 \cdot x + 2 = 6$ was the equation, but it was actually $2 \cdot x + 4 = 6$. This is known as an "error in logic" or just a "logic error".

Sometimes it's obvious that you made a mistake because the answer is obviously wrong. For example, seeing "-1" when you are expecting the answer to "2+3" is obvious because you know already that you shouldn't get an answer which is a negative number. Sometimes it isn't so obvious, so you need a way to check the correctness of the result.

### 2.4 Saving and retrieving your work

You can save your work in a Maple worksheet file through the File -> Save (keyboard shortcut: control/command-S) menu item of the Maple application. A dialog box appears allowing you to type in the name of the worksheet (we've typed in "test" into the box in the .)

The file is saved with a ".mw" suffix (e.g. test1.mw).

To retrieve the file in a subsequent Maple session, start up the Maple application as before and then use the File->Open menu item to initiate the dialog that retrieves the file.

#### Maple save menu operation

#### Maple save dialog box

### 2.5 Retrieving backups

The "state of Maple" display appears on the bottom left hand side of the Maple window. Usually this display says "Ready", which means that Maple is awaiting your next command. Sometimes it reads "Evaluating..." which indicates that Maple is actively computing an answer. Sometimes it says "Autosaving worksheet", which means that it is saving a copy of the present state of your open worksheets into temporary storage on your computer. The amount of time Maple spends autosaving becomes noticeable in longer Maple sessions when the worksheet contains a lot of results.

Should your computer suddenly lose power or should Maple crash, you can retrieve the last autosaved worksheet by selecting the File -> Recent Documents -> Restore Backup menu item. This will fill your Maple with copies of all the autosaved worksheets. You may then delete them or save them to permanent file space as you wish.
Algebraic expressions and equations. Solving equations. Working with pieces of expressions.

We don't have to limit ourselves to just numerical calculation in Maple (even if the ability to use many digits and exact fractions allows us to do math more like the math books do). Another distinctive feature of Maple is that you can do algebra by entering expressions with symbols -- the \(x, y, z, i,\) and \(n\) that we see on algebra books. Maple will automatically collect terms and do some simplifications for us automatically.

\[
x^2 + 2x + 5 + 3x
\]

\[
x^2 + 5x + 5 \quad (2.34)
\]

We can even enter \textit{equations}:

\[
\frac{3}{5}x + 1 = 4 - x
\]

\[
\frac{3}{5}x + 1 = 4 - x \quad (2.35)
\]

\[
3x + 1 + 4x = ax + b
\]

\[
7x + 1 = ax + b \quad (2.36)
\]

Note that while Maple automatically collected the \(x\) terms on the left hand side of the equation, it does not try to do the more interventionist operation of moving all the \(x\) terms to the same side of the equation.

Now, enter the following expression, but rather than hitting the enter key after you've entered it, do a right-click. On the Mac, instead of right-clicking hold the control key down then click on the mouse button (this is referred to as "control-click".) A menu of algebraic operations will pop up. Select "factor" and see how Maple can factor the polynomial:

\[
x^2 + 5x - 50 \quad \text{factor} \quad (x + 10) (x - 5)
\]

Note that this line does not have a (XX) label for it. To further demonstrate the right-click (control-click) operations available, enter the following equation. Right click on the expression and a pop-up menu should appear that includes a "solve" item. Select the solve and a submenu will appear where you can specify that you want to solve for \(x\).
For the previously experienced: some things are different, for a reason

(This section is for people who already know a programming language and are noticing that Maple does some things differently. Other readers can skip this section.) Most mainstream programming languages work in a similar way. That is why learning Maple has value beyond just being able to use the Maple system -- once you learn Maple, learning Matlab or Java or C is a matter of incremental adjustment. Noticing the differences is educational in that it makes you become aware of the arbitrariness of some features of languages. If you have used another programming language such as Java or Visual Basic, you will notice that some things do not work the same in Maple as they do there. Some of this can be explained if you know something about the history of programming languages. Some of it is explained by being aware that the designers of Maple had different goals than those who invented Java or VB.

One thing that you have undoubtedly noted is that symbols do not have to have a value associated with them. For example, in Java if you said k=5; Then if you were to create another expression in Java such as System.out.println(k^2 + k + k + 3); then "5" would be used as the value of k in the expression and you would end up printing 38. In Maple, you do not have to associate k with a numerical value before you use k in an algebraic expression. If there was no prior association, Maple just treats the expression as a formula with symbols in it. It may do some algebraic simplification on what you entered, but it does not need to get a number as a result. Since there was no prior assignment for the expressions in section 2.5.1, the calculation done with them just keeps the formula.

Another thing that is different is that in Maple "=" is used for equations, not assignment. The operator in Maple corresponding to "=" in Java or VB is ":=" (a colon immediately followed by an equals, with no spaces inbetween). In Maple, if we wanted to associate "5" with the symbol k, then we would do:

$$k := 5$$

$$5$$

$$k^2 + k + 3 + k$$

$$38$$

People who know more than one programming language have a better understanding of which features are change a lot between languages, (such as whether = or := is used for assignment), and which ones are fairly uniform (+ being used for addition, or the use of parentheses in functions and expressions). Maple does not use "=" for assignment because, being a mathematically oriented language that can handle algebra, it wants to make the entry of equations a natural thing. Its use of ":=" for assignment is a feature borrowed from the Algol/Algol 68/Pascal family of programming languages, which picked this operator to make it clear that this operation was not algebraic.

Is ":=" better than "="? That's a kind of question that is about as hard to answer as trying to decide whether "uno" is better than "one". If one had a language where you had to do ":==****&%##%++++" instead of "=" or ":="; you could be critical of the choice because it takes much more effort to enter a 35 character operator than a one or two character one. But Maple's choice of ":=" has reasonable motivation -- "=" is used as a natural way to enter equations (which Java and VB do not support linguistically), and ":=" suggests something similar while being distinctly different. Just as with architectural design of a building, each feature of a programming language is typically carefully considered. Many features are borrowed or copied from predecessor languages, where they have already been subjected...
to the test of many people using the feature. If you are not familiar with Algol family languages, you can see examples of them at various educational web sites, such as http://www.engin.umd.umich.edu/CIS/course.des/cis400/algol/average.html and http://portal.acm.org/citation.cfm?id=154766.155365).

Plotting and approximate numerical solutions

The right-clickable interface can also activate a plot of a formula you may have entered. Enter this formula, then right-click and select Plot ->2d plot. The automatic defaults for plotting this produce this result.

If we click on the plot and then position the mouse over the plot area, we see in the upper left hand corner of the Maple application a pair of coordinates that change as we move the mouse around. We can "eyeball" the plot with this to find approximately where this formula is equal to zero. From the figure below we can see that \( x^2 - 10 \cdot x + 4 \) is zero at about .5 and 9. We could position the cursor in those areas to get a more precise (but still rough) estimate.
Plot created by right-click -> Plot -> 2DPlot.

User has clicked on the plot and positioned the cursor at the coordinate (-3.08, 45.78). The cursor was not captured by the screenshot although it is visible under ordinary use.

The 2DPlot operation makes pre-set decisions about the plot, such as the range of \( x \) (-10 to 10), the color of the line, axes labeling, etc. Users can inject their own preferences about these things about this by selecting right-click -> Plot -> PlotBuilder and filling in the dialog box with their choices.

User-configured plot using PlotBuilder instead of 2DPlot
The Expressions Palette and the Common Symbols Palette: entering Trigs, logs, roots, exponentials

It's possible to get the common functions of high school algebra, pre-calculus, and calculus by using the Expression palette of the Maple Window:

For example, to enter the square root of 36, click on the palette entry for $\sqrt{a}$. That expression will appear in the document, with the "a" selected. If you then type 36 on the keyboard, that number will replace the selected text. If you then hit the enter key, Maple will evaluate the expression and produce the exact result "6".

$$x + y + \frac{1}{2} + \frac{1}{4} + \sqrt{36}$$

$$x + y + \frac{27}{4}$$

(2.39)

You can use the palette multiple times, to create more complicated expressions. Just continue to the use mouse or the arrow keys to move around in the expression. Selecting and typing, backspacing or deleting are all ways of replacing or correcting pieces of the expression. The Common symbols palette, two panels below the Expression palette, can be used to enter $\pi$ and $e$, the base of the natural logarithm system. The palette does not have the inverse trig functions, so you have to enter them through typing. Their names are: arcsin, arccos, arctan, etc.
Examples of palette-driven computation

\[
\sin\left(\frac{\pi}{4}\right) + \cos\left(\frac{\pi}{4}\right) = \sqrt{2} \tag{2.40}
\]

\[
\left(\sqrt{1024} + \ln\left(e^{\frac{2}{3}}\right)\right) \cdot \pi = \frac{98}{39} \pi \tag{2.41}
\]

\[
\arcsin\left(\sin\left(\frac{1}{4} \cdot \pi\right)\right) = \frac{1}{4} \pi \tag{2.42}
\]

Approximate numerical (calculator - type) arithmetic in Maple

If you enter expressions with integers, exact fractions, and symbols such as \(\pi\) and \(e\), then Maple will perform exact calculations rather than give approximate answers as a conventional calculator would. You can get approximations by selecting the "numerically solve" instead of the "solve" option from the right-click pop-up menu.

Examples of computing with approximate solving

<table>
<thead>
<tr>
<th>Expression</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>(x^2 - 10 \cdot x + 4)</td>
<td>(x = 5 + \sqrt{21}), (x = 5 - \sqrt{21})</td>
</tr>
</tbody>
</table>

Exact solution of an equation using the "solve" feature of the pop-up menu.

<table>
<thead>
<tr>
<th>Expression</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>(x^2 - 10 \cdot x + 4)</td>
<td>0.4174243050, 9.582575695</td>
</tr>
</tbody>
</table>

Using the "numerically solve" feature of the pop-up menu.

If you have an exact expression, you can ask Maple to approximate it to 5, 10, 20, or more digits. In this mode, Maple can be used as a super-accurate calculator.

Examples of numerical computation

1. Enter fraction, select approximate->20 from right-click pop-up menu.

\[
\frac{47}{52} + \frac{4}{3} \stackrel{20\text{ digits}}{\rightarrow} 2.2371794871794871795
\]

2. Enter exact expression, select approximate->5 from right click pop-up menu

\[
\sin\left(\frac{\pi}{10}\right) \stackrel{5\text{ digits}}{\rightarrow} 0.30902
\]

3. Enter equation. Then solve->solve, then select Element->1, then right hand side, then approximate->10
Evaluation at a point, and selection of pieces

Sometimes you wish to evaluate an expression for a particular value of a variable. There is a right-click operation that does this.

Evaluate at a point

<table>
<thead>
<tr>
<th>Operation</th>
<th>Expression</th>
<th>Result</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x^2 - 2 \cdot 2 \cdot x = 0$</td>
<td>$a = 0$</td>
<td>This operation will give a pop-up menu that will allow us to choose values for all the variables. In the first example, we picked $1/2$ for a value of $x$. Note that the pop-up menu will show what you typed rather than displaying 2D math. In the second example, we specified &quot;$3y^2$&quot; as the value for $a$. In the third example, we picked $3$ as the value for $y$.</td>
<td></td>
</tr>
</tbody>
</table>

Expressions often have pieces. Using the right-click menu, it's possible to select or extract a portion of an expression for further work.

Operations on equations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Expression</th>
<th>Result</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x = \frac{\sin(a)}{r^2 - 1}$</td>
<td>$\sin(a)$</td>
<td>One of the options in the right-click menu is &quot;right hand side&quot;. It only works for equations.</td>
<td></td>
</tr>
</tbody>
</table>

Operations on multipart expressions

<table>
<thead>
<tr>
<th>Operation</th>
<th>Expression</th>
<th>Result</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x^2 - 4 \cdot x = 4$</td>
<td>solve for $x$</td>
<td>${x = 2 + 2\sqrt{2}, x = 2 - 2\sqrt{2}}$</td>
<td>Solving this quadratic equation reveals that there are two solutions. Right clicking on these selections and then select entry $\rightarrow 1$ produces the first solution. We can then approximate it by using the</td>
</tr>
</tbody>
</table>

2.6 Algebra, plotting and mouse-clickable operations • 23
2.7 A quick-reference summary to this chapter

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arithmetic</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| \[
\begin{align*}
2 + \frac{3^2}{4} - \frac{1}{6}
\end{align*}
\] | Use +, *, -, /, ^ for arithmetic. Hitting the Enter key produces a labelled result. | 2 D Math input mode displays the textbook-like version of what you input. Maple's simplification automatically combined fractions and places things in lowest terms. |
| \[
\begin{array}{c}
\frac{49}{12}
\end{array}
\] | (24) | |
| **Making mistakes** | | |
| \[
\begin{align*}
2 + \left( \frac{3}{5} \right)
\end{align*}
\] | Error message mistakes (from typos or mistakes in intensions) | The easiest ones to detect. You have to figure out what you are doing wrong, though. The error message may not always be helpful in advising you on this, although it often is. |
| Error, unable to match delimiters | | |
| | (24) | |
| A farmer plants a fence post every foot, for 1250 feet. At that point, he switches to planting the fence posts every 4.7 feet for another 940 feet. How many fence posts does he need in all? | "Logic errors" | You are asking Maple to compute something that it understands, so it gives you an answer. However, this answer doesn't really solve your problem. You need to find a more appropriate computation, which you can only do by thinking about whether you went wrong. Often you can find these kinds of mistakes by looking at simpler versions of the problem where the answer can be figured out with paper and pencil. Then you can "scale up" the answer to handle the actual problem you have.

The correct answer is 1251 + 201 1452 fence posts. The computer did what it was asked to do -- the problem was that it was asked to do the wrong thing. |
| \[
\begin{align*}
\frac{1250}{1} + 940 \div 4.7
\end{align*}
\] | (28) | |
| \[
\begin{array}{c}
1450.00000
\end{array}
\] | | |
| **Editing (fixing mistakes)** | | |
| backspace, delete erase starting from current cursor selection | | |
| Arrow keys→← move cursor within current selection | | |
Select with mouse/type replaces selected text

Cut, copy and paste of a selection works as it does with a text processor

**File saves, opens**

Save files with File -> Save or File -> Save As. Open a saved file with File -> Open. Other File operations similar to that of standard word processors.

**Functions**

\[
\frac{3}{\sqrt{\csc \left( \frac{\pi}{2} \right)}} + e \\
(1 + e)^{1/3} \\
\ln(e^2 - \sqrt{e}) \quad \text{simplify symbolic} \quad \frac{5}{2}
\]

Insert math into an expression by using the Expression and Common Symbols Palette.

Chapter 2 demonstrated the following functions and symbols

<table>
<thead>
<tr>
<th>Square roots, ( n )-th roots</th>
<th>natural logarithms (base ( e ))</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trig functions: ( \sin, \cos ) (trig functions all use radians, not degrees)</td>
<td>Base 10 logarithms</td>
</tr>
<tr>
<td>( \arcsin, \arccos, \arctan )</td>
<td>( \sec, \csc )</td>
</tr>
<tr>
<td>summation</td>
<td>( \pi, e )</td>
</tr>
</tbody>
</table>

**Algebra**

\[x^2 - 2x - 15 = 0 \quad \text{left hand side} \rightarrow \quad x^2 - 2x - 15 = 0 \quad \text{factor} \rightarrow \quad x^2 - 2x - 15 = 0 \quad \text{factor} \rightarrow \quad (x - 5)(x + 3)
\]

Right-click (control-click on Mac) on an entered expression to get the pop-up menu.

Chapter 2 demonstrated examples of the following operations:

<table>
<thead>
<tr>
<th>factor</th>
<th>solve</th>
</tr>
</thead>
<tbody>
<tr>
<td>solve numerically</td>
<td>right hand side (of an equation)</td>
</tr>
<tr>
<td>left hand side (of an equation)</td>
<td>select (n-th part) of an expression</td>
</tr>
<tr>
<td>approximate numerically (to 5, 10, 20, etc. digits' accuracy)</td>
<td>plot (two-dimensional) -- many plot options to determine range and domain of plot, color, captions, etc.</td>
</tr>
<tr>
<td>evaluate at a point (choose values for variables in an expression)</td>
<td></td>
</tr>
</tbody>
</table>

**Plotting**
The expression must be something that involves a single variable and will result in a number when a value is used for that variable. Thus you can't do a 2d plot of \( x^2 - a \) because you wouldn't get a number if you picked a value just for \( x \) (or just for \( a \)). Maple uses defaults for the plot range, and the plot color.

Trying to plot an equation produces an implicit plot (see next appendix).

<table>
<thead>
<tr>
<th>Plots-&gt;2d plot</th>
<th>( x^2 - 1 \rightarrow )</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

A dialog box appears that allows you the select from many more options, such as plot color, the line style, vertical and horizontal ranges, captions, etc.

<table>
<thead>
<tr>
<th>Plots-&gt;plot builder -&gt; 2d plot</th>
<th>( x^2 - 1 \rightarrow )</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Limited precision (decimal point) numbers

\[
\cos(x^2) = \sqrt{x} \quad \text{solve} \quad 0.7352027350
\]

\[
0.1 + \frac{2}{3} + \tan(1) + \pi^2
\]

\[
= 0.7666666667 + \tan(1) + \pi^2
\]

\[
\text{at 20 digits}
\]

\[
2.324074391354902235
\]

\[
+ 3.14159265
\]

\[
35897932385
\]

Exact numbers in Maple have no decimal points. Numbers with decimal points in Maple cause arithmetic calculations to be done approximately. solve->numerically solve produces approximate solutions. Right-click->approximate->n takes an exact numerical expression and approximates it.

Use of limited precision numbers in algebra (e.g. factoring, differentiation, solving) may not produce good results. Use them in Maple only when an approximate result is desired.

Numbers like .25 or .6015 are limited precision. If you want exact algebra done, use 1/4 or 6015/10000, etc.

In very large calculations, limited precision calculations may be noticeably faster than those with exact arithmetic. Most of the time there isn't an appreciated difference.

<table>
<thead>
<tr>
<th>Limited precision (decimal point) numbers</th>
<th>Evaluate at a point</th>
<th>Example</th>
</tr>
</thead>
</table>
This operation will give a pop-up menu that will allow us to choose values for all the variables. In the first example, we picked 1/2 for a value of \( x \). Note that the pop-up menu will show what you typed rather than displaying 2D math. In the second example, we specified "3*y^2" as the value for \( a \). In the third example, we picked 3 as the value for \( y \).

### Operations on multi-part expressions

**Example**

**Select entry**

\[
x^2 - 4 \cdot x - 4 \quad \text{solve for } x
\]

- solve for \( x \) \[
\begin{align*}
+ 2 \sqrt{2} & \quad \text{select entry 1, } x = 2 \\
- 2 \sqrt{2} & \quad \text{select entry 1, } x = -2 \\
\end{align*}
\]

- select entry 1 \( x = 2 \)

- select entry 1 \( x = 2.792 \text{ at 5 digits} \)

This reveals that there are two solutions. Right clicking on these selections and then select entry \( \rightarrow 1 \) produces the first solution. We can then approximate it by using the

Enter an expression in a document, then right-click (control-click on Mac) followed by:

### Operations on symbolic expressions

<table>
<thead>
<tr>
<th>Example</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>( x^2 - 1 )</td>
<td>( { x = 1 }, { x = -1 } )</td>
</tr>
<tr>
<td>( x^2 - 2 \cdot a \cdot x = 0 )</td>
<td>( { x = 0 }, { x = 2 \cdot a } )</td>
</tr>
<tr>
<td>( x = \cos(x) )</td>
<td>0.739085132</td>
</tr>
</tbody>
</table>

The thing to try when there is a numerical answer but the exact solution is too complicated to understand or Maple can't find an exact solution.
### Factoring

\[
x^2 - 1 \overset{\text{factor}}{=} (x - 1)(x + 1)
\]

\[
\cos(x)^2 - \sin(x)^2 \overset{\text{factor}}{=} (\cos(x) - \sin(x))(\cos(x) + \sin(x))
\]

Factoring can simplify an expression sometimes. Factoring doesn't know the trig simplification rules, though.

### Plots->2d plot

\[
x^2 - 1 \rightarrow
\]

The expression must be something that involves a single variable and will result in a number when a value is used for that variable. Thus you can't do a 2d plot of \( x^2 - a \) because you wouldn't get a number if you picked a value just for \( x \) (or just for \( a \)).

Maple uses defaults for the plot range, and the plot color.

### Plots->plot builder -> 2d plot

\[
x^2 - 1 \rightarrow
\]

A dialog box appears that allows you the select from many more options, such as plot color, the line style, vertical and horizontal ranges, captions, etc.

### Operations on equations

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
</table>
| right hand side, left hand side | \[
x = \frac{\sin(\alpha)}{\sqrt{2} - 1} \rightarrow \frac{\sin(\alpha)}{\sqrt{2} - 1}
\]
| \[
x = \frac{\sin(\alpha)}{\sqrt{2} - 1} \rightarrow \frac{\sin(\alpha)}{\sqrt{2} - 1}
\] |
<table>
<thead>
<tr>
<th>Move to right, move to left</th>
<th>( x^2 + x + 1 = a ) move to right</th>
<th>( 0 = a - x^2 - x - 1 )</th>
<th>This moves the entire side of an equation to the other side.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operations on constant expressions</td>
<td>Example</td>
<td></td>
<td></td>
</tr>
<tr>
<td>approximate -&gt; 5 (or 10, 20, 50)</td>
<td>[ \tan \left( \frac{\pi}{10} \right) \sqrt{10} ] ( \approx ) 0.34157868529293212152</td>
<td>( x = \ln(5000!) ) at 20 digits</td>
<td>( x = 37591.143508876766569 )</td>
</tr>
</tbody>
</table>
Index

Symbols
! (exclamation point factorial), 10
(, 9
), 9
- (minus or dash), 9
= (equation), 17
^ (caret), 10

A
addition (+), 9
arc cosine, 21
arc sine, 21
arc tangent, 21
arithmetic, 8
  approximate, 22
  exact, 11
  operations, 8
asterisk, 9
autosaving, 16
Axiom, 5

B
backspace key, 13
backups
  retrieving, 16

C
C, 6
C (the programming language), 5
C++ (the programming language), 5
caret (power), 10
circle-X, 7
command-C (copy operation), 14
command-V (paste operation), 14
command-X (cut operation), 14
computing
  algebraic, 1
  graphical, 1
  high performance, 3
  logical, 1
  numerical, 1
control-C (copy), 14
control-click, 17
control-V (paste operation), 14
control-X (cut operation), 14
copy (editing operation), 14

crash
  Maple, 16
cut (editing operation), 14

D
dashed rectangle, 7
delimiters in Maple: ( ) [ ] { }, 12
digits, 22
division (/), 9
documentation
  need for, 2
dot
  centered, 10

E
equation, 17
error
  invalid fraction, 13
  invalid matrix/vector product, 12
  invalid sequence, 13
  invalid sum/difference, 12
  logic, 16
  missing operation, 12
  numeric exception: division by zero, 12
  unable to match delimiters, 12–13
  vocabulary, 15
error message, 11
evaluating
  state, 16
evaluation
  of expressions, 8
exponentiation, 14
expressions
  algebraic, 17
  from palette, 21

F
factor, 17
factorial (!), 10
fence post error, 24
Fortran, 5

G
gigaflop, 3
graphical user interface (GUI), 4
GUI, 4

H
help
  quick, 7
I
interactive, 5
inverse trig functions, 21

J
Java, 5

L
label, 8
left arrow key, 13
left hand side (right-click menu), 23, 27
linear algebra, 12
logic error, 16, 24
Los Alamos National Laboratory, 3

M
Macsyma, 5
Maple, 4
document mode, 7
Maple 13, 4
Mathematica, 5–6
mathematical model, 1
Matlab, 5
Symbolic Toolkit, 6
maxdigits, 15
minus, 9
mistake
typographical
how to fix, 13
multiple systems, 6
multiplication (*), 9

N
negation (-), 9

O
Oak Ridge National Laboratory, 3
Octave, 5

P
palette, 21
square root, 21
parentheses, 9
paste (editing operation), 14
petaflop, 3
plotting, 19
plus, 9
power (^), 10
Python, 5–6

R
ready
Maple, 16
rectangle
dashed (entry), 7
restore, 16
retrieving
a Maple session, 16
reuse
of software, 2
right hand side (of equation), 22
right hand side (right-click menu), 23, 27
right-click, 17

S
Sage, 5
Saving
a Maple document, 16
select entry (right-click menu), 23, 27
sequence, 13
simulation, 1
slash, 9
solve
by right-clicking or control-clicking, 17
numerical, 22
square root
from palette, 21
state display
of Maple, 16
subtraction (-), 9
supercomputer, 3

T
teraflop, 3

V
visualization, 1